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IMPORTANT 

1. The copyright of this software belongs to PLUS CORPORATION and PLUS 
INDUSTRIAL CO.,LTD. 

2. It is forbidden to use or copy a part or the whole of the software or manual without 
permission.  

3. The software and manual may be used only in accordance with the terms of the 
agreement. 

4. We do not accept any responsibility for effects resulting from use of the software or 
manual. 

5. The specifications of the software and items described in the manual are subject to 
change without notice.  

MS, Microsoft, Windows, Windows 95 and Windows NT are registered trademarks in 
the United States and other countries of Microsoft Corporation. 

IBM is a registered trademark of International Business Machines Corporation.  

i486 is a trademark of Intel.  

All Borland products are trademarks or registered trademarks of Borland International, 
Inc. of the United States. 

Async Professional for Delphi is a registered trademark of TurboPower Software Co. of 
the United States. 

Other names of companies and products mentioned are trademarks and registered 
trademarks of the respective companies.  

™, ® and © marks are not used in this document. 

COPYRIGHT 

(1) The copyright of this Software belongs to the copyright holder decided by this company. 
The copyright covering reproduction also belongs to the copyright holder. However, the 
recording medium does not belong to the copyright holder. 

(2) The Software has been prepared by the following tools for which the copyright is held 
by the respective developer. 

· Delphi (Developed by Borland International, Inc.) 

· Async Professional for Delphi (Developed by TurboPower Software Co.) 
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 1  INTRODUCTION 

Welcome to PLUS BOARDWARE ! 

The SOFTWARE SETUP MANUAL (hereafter referred to as the manual) describes how to 
connect the PLUS Copyboard BF-030PC or BF-060, and how to set up and start the 
software. Please use it to ensure correct and efficient use of the software. 

For instructions on how to use the Copyboard, please refer to the Copyboard BF-030PC or 
BF-060 OPERATION MANUAL. 

1.1 Environment  

• Appropriate PC type We over recommend IBM PC/AT personal computers and 
completely compatible computers with at least an i486/66 
MHz CPU and standard COM port (16550 or later UART 
chip recommended). 

 

• OS Microsoft Windows 95(hereafter referred to as Windows 

 

• Memory Over 16MB (Recommended OS memory) 

 

• Hard disk space Blank area of over 5MB required  

 

1.2 Notes  

• Software Backup  

Before installing the software or opening an original file by some method, it is advisable to 
make a copy of the software for backup purposes. 

 

• Latest Information 

The latest information concerning the program and manual and trouble-shooting procedures 
are found in the README.TXT enclosed with the disks. Please read it before commencing 
operation.  
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1.3 Terms and Symbols  

The following terms and symbols are used in the manual and online Help. 

 

Menu, Command and Dialog Box 

Term/Symbol Explanation  

<File> Menu Menu names and commands are enclosed in < > brackets 

[OK], [Cancel] Names of Dialog Box command buttons and Toolbar buttons are 
enclosed in [ ] brackets 

  

Mouse Operation   

Term/Symbol Explanation  

Point Move the mouse until the pointer is on the desired operation 

Click Press the mouse button, then release it immediately  

Double click Click the mouse button twice in rapid succession 

Drag While pressing the mouse button, move the mouse and release the 
button at the desired position 

  

Keys   

Term/Symbol Explanation  

Enter The key is shown in bold 

Alt + F1 Such combinations are called short-cut keys. Plus sign (+) 
indicates 2 or more keys are to be pressed simultaneously. For 
example, Alt + X means to hold down the Alt key while pressing 
the X key.  

Cursor keys Name for →,←,↑,↓keys 

 

In the explanation of the operating method, <Mouse> means mouse operation, <Keyboard> 
means keyboard operation and <Toolbar> means toolbar operation.  
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 2  HARDWARE SETUP 

2.1 Setting Up the Copyboard BF-030PC  

(1) Make sure the power to the personal computer and Copyboard are switched off. 

(2) Use the interface cable provided and connect the connector at the bottom of the 
Copyboard to the serial port (DB9F (9 pins) COM 1 or COM 2 Port) on the 
appropriate type of personal computer. *1 

 A noise suppressing ferrite core (A) is provided at one end of the cable. Make sure 
that this end is connected to the Copyboard connector.   

(3) Switch the power on. Preparations are completed when the fluorescent lamp lights up 
after about 4 sec. 

(4) Start up the personal computer.  

 

Personal Computer

INTERFACE CABLE

(A)

PLUS COPYBOARD
BF-030PC

 

 

Fig. 2.1 

*1 If the COM Port on the PC is not DB9F but DB25F (25 pins), an interchangeable 
DB9F/DB25F connector can be purchased as an option. 
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2.2 Setting Up the Copyboard BF-060  

2.2.1 Package Contents  

The following items are enclosed in the package. 
In the event an item listed among the package contents is found to be missing or damaged 
immediately request a replacement from your retail store. 

・PC interface board unit   1 pc. 

・PC connection cable (D-sub 9 pin 2m)   1 pc. 

・Setup manual (this document)   1 set 

・Setup disk (floppy disk)   1 disk 

・User registration card   1 copy 

 

ADDED FUNCTIONS 

・EXTRA COPY key : Use for making an additional copy after making a copy of 
one side or a PC copy. Do not move the sheet at this time. 

・PC COPY key  :Use to feed a copy of one side to the computer. The main 
unit printer will not operate at this time. 

 

 

 

 

CONTROLS  EXTRA COPY key 

 
 PC COPY key 
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2.2.2 Setup  

Setup the PC interface board according to the following procedure instructions. 

* Switch off all power to the main unit (electronic blackboard) and the PC before starting 
operations. 

* Touch some nearby metal (for example a door knob or aluminum sash) to discharge any 
static electricity built up on your body or clothes before starting operations. 

 

(1) Loosen the screws securing the cover over the 
expansion slot on the lower part of the unit, and 
remove this cover. 

 

(2) Insert the PC interface board making sure it is 
correctly aligned with the slot guide and secure it 
in place with the screws just removed. 

 

(3) Plug the PC connection cable into the PC interface 
board and plug the other end into the RS-232C 
connector on the PC.  One end of the cable has a 
ferrite core to prevent noise (A).  Connect this 
end to the main unit side connector. 

 A noise suppressing ferrite core (A) is provided at 
one end of the cable. Make sure that this end is 
connected to the Copyboard connector. 

  

(4) Switch on the main unit power and complete preparations. 

(5) Start up the personal computer. 

 

* If the only serial port you can use as 25 pins instead of 9 pins, please purchase the 
optional 9 pin/25 pin converter connector. 

cover 

M3 x 6 (2 screws) 

(A) 
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 3  SOFTWARE SETUP 

 

3.1 Setup  

Before Installing 

Please be sure you have read the software license agreement at the front of this manual 
before installing BOARDWARE. 

Installation 

Install BOARDWARE with the procedure below. 

(1) Start Windows 95 or NT and insert the BOARDWARE diskette into a disk drive. 

(2) From the [Start], select <Settings> then choose <Control Panel>. 

(3) Choose <Add/Remove>Programs. 

(4) Choose the [Install/Uninstall] tabs and then select the [Install] button.  At the next 
screen, insert the disk and select the [Next] button.  It will detect the disk and display 
<A:SETUP.EXE> in the command line edit box. 

(5) If the <SETUP.EXE> is not detected, you may select the [Browse] button to select a 
different path.  Select <SETUP.EXE> and choose the [OPEN] button. 

(6) At the Run Installation Program screen, select the [Finish] button to begin the actual 
Setup. 

(7) Follow the instructions on the Setup screens. 

(8) When prompted, restart your computer to change system settings. 

When installation has been completed normally, all the files are copied.  The destination 
directory for copying can be specified during installation.  If no destination directory is 
specified, the ¥PLUSBW directory is made in the root directory and the files are copied 
there. 

3.2 Uninstall  

(1) Select <Control Panel > and choose <Add/Remove> Programs. 

(2) Select BOARDWARE, then click [Add/Remove (R)]. 

(3) The uninstall program is executed and BOARDWARE is removed. 
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 4  OPERATION 

4.1 Starting/Exiting 

Before starting PLUS BOARDWARE, check that the interface cable is connected, the power 
to the Copyboard is switched on and the lamp is on. If you have any problems, follow the 
setup procedure again. 

Note: When the power is switched on, the lamp lights up after about 4 sec and the 
Copyboard is on standby. The Copyboard cannot be operated until the lamp 
comes on. Check that the lamp is on before starting the program.(BF-030PC 
only) 

Starting PLUS BOARDWARE  

From [Start], select the group in which PLUS BOARDWARE is registered, then click PLUS 
BOARDWARE. 

The connection with the main unit is checked and initialized.  When this process has 
completed normally, the “Complete Initialize” dialog is displayed and processing moves to 
the main menu. 

Ending PLUS BOARDWARE 

Click the close button [X] or click <Exit> in the File menu. 

4.2 Operating Method 

An explanation of how to operate PLUS BOARDWARE and the various commands is 
available in the online Help.  

You can open Help by selecting <Contents> from the Help Menu.  

For instructions on how to use Help, refer to the Windows manual or <How to Use Help> 
from the Help Menu. For troubleshooting procedures, refer to the README file.  
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 5  USER SUPPORT 

An inquiry service for questions relating to the software etc., and information about 
upgrading are only available to registered users. Fill in the necessary items on the enclosed 
Registration Card and return it to us as soon as possible. 

5.1 Inquiries  

If there is something you do not understand about PLUS BOARDWARE, first consult the 
manual, HELP file and README contents. If you cannot find the necessary information in 
the manual, contact the store where you purchased PLUS BOARDWARE or access the 
PLUS INTERNET TROUBLESHOOTING web site below. 

Home page address    http://www.TokyoWeb.or.jp/PLUSdmt/  

• IMPORTANT  

We are unable to reply to inquiries in the following circumstances.  

· When PLUS BOARDWARE is used in an environment other than that for which 
the product is guaranteed  

· When the inquiry concerns basic software (OS etc.) or hardware 

5.2  Upgrading 

For details on version upgrades, please ask at the store where you purchased this product. 
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 6  CAUTION 

6.1 Working Environment  

This product is a precision piece of equipment.  The warranty does not cover breakdowns 
or trouble on the computer or breakdowns or trouble on the PC interface exp ansion board 
occurring due to incorrect handling. 

uCAUTIONS ON HANDLING 
q Be sure to eliminate all static electrical charges on the body or clothes before attempting 

installation of the PC interface. 
q Do not handle with moist hands or fingers. 
q Do not attempt unauthorized repairs or modifications. 
q Avoid using the board in the following locations. 
n Locations subject to magnetic fields, static charges or vibrations. 
n Locations near flames or heated air. 
n Locations subject to moisture leaks or electrical discharges. 
n Locations with humidity exceeding 80% or condensation. 
n Location in the path of direct sunlight. 
n Locations prone to cause damage to the computer or the Copyboard. 

uCAUTIONS REGARDING INSTALLATION 
WARNING: q Be sure to turn the power on the computer and the Electronic 

Blackboard off before attempting installation. 

CAUTION: q Read the manual thoroughly before handling the Electronic Blackboard 
or the computer. 
Remove any dust or contamination from the connectors before using. 

6.2 Restrictions 

PLUS BOARDWARE Ver.2.0 is a 32bit Code application.  

It does not function on Windows 3.1. As it has not been confirmed for operation on 
Windows NT 3.51, it is outside the range of our support system. 
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3-B22 NAKASE 1-CHOME, MIHAMA-KU, CHIBA 261-01 JAPAN 

PHONE: 043-296-3056  FAX: 043-296-3025 
TELEX: J22113PLUSJIM, CABLE PLUSJIMUK TOKYO 


